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This user guide provides basic instructions for setting up SEADA G24 HDM I video wall controllers using
its management software.
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1. Product Introduction

1.1. Product profile

The G24 HDMI version of video wall controller accepts up to 2 HDMI inputs and displays them on 4
different displays, each with a resolution up to 4K@60fps 4:4:4. G24 HDMI not only allows the user to
display a single input across all four screens, but also to display different input videos onto different
screens working like a matrix switcher. Moreover, it also supports analogue L/R audio and digital
SPDIF audio output.

1.2. Product capability

Two HDMI 2.0 inputs with embedded audio

Four HDMI 2.0 outputs with embedded audio

Each input and output support resolutions up to 4K@60Hz 4:4:4
Support up and down scaling on each output

Support 1802 rotation

Support PIP on video wall

Support 2 channels HDMI loop out

Support daisy chain

Balanced analog audio output

L/R analog audio output

Toslink digital audio outputs

Support audio embedded and de-embedded

Support Bezel Compensation

Support CEC management

Support EDID management

Custom pre-set layouts

HDCP compliant

Support adjusting display settings such as contrast and saturation remotely
Controllable via IP/serial port

www.seada.co.uk
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1.3. Specifications

Technical
HDMI Compliance HDMI 2.0
HDCP Compliance HDCP 2.2/1.4

RS-232 Baud rate: 57600, data bit: 8, Stop bit: 1, no parity
4096x2160p 24/25/30/50/60Hz 1400x1050 60Hz
3840x2160p 24/25/30/50/60Hz 1366x768 60Hz
1080p 24/25/30/50/60Hz 1360x768 60Hz

. 1080i 50/60Hz 1280x1024 60Hz

Input Video Formats
1920x1200 60Hz 1280x960 60Hz
1680x1050 60Hz 1280x800 60Hz
1600x1200 60Hz 1024x768 60Hz
1440x900 60Hz 1280x720p50/60Hz

Audio Format 2.0 channel, 5.1 channel, LPCM, Dolby, AC3, DTS

Human-body Model:

ESD Protection
I +8kV (Air-gap discharge), +4kV (Contact discharge)

Mechanical

Housing Metal Enclosure

Color Black

Dimensions 218mm (W)x146mm (D)x43mm (H)
Weight 2Kg

Supply Voltage +12V/3A

Power Consumption | 25W (Max)

Operating 0°C ~40°C/32°F~ 104°F
Temperature

Storage -20°C~ 70°C / -4°F ~ 158°F
Temperature

Relative Humidity 10%~50% RH (non-condensing)

www.seada.co.uk
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2. Hardware Overview
2.1.Front Panel

SEA G24
Showing the World —INPUT— — LOOP — QUTPUT
T YT LT Ty
VIDEO WALL CONTROLLER
| | |
O 0 6 (4
No. Name Function Description
1 Power LED |Power LED will be on when the unit is powered on.
5 INPUT LED |The LED will be on when the corresponding HDMI input port is connected
to active HDMI source device.
3 LOOP LED |The LED will be on when the corresponding LOOP OUT port is connected
to HDMI display device.
4 OUTPUT The LED will be on when the corresponding HDMI output port is
LED connected to HDMI display device.
2.2. Rear Panel
o _?ii X b R ? u“ﬂg&”
[ i il | o | i C€ FE =
AN rszzcrl  rszz | ueoare | matancebour  rosi
[ a0 oo oo o o =
L (.«?gA INPUTS - ’ LOOP OU:WIAIN " " OUTPUTS . - j
No. Name Function Description
1 INPUTS HDMI signal input ports, connect to HDMI source devices
2 LOOP OUT |HDMI signal loop out ports. Loop out HDMI A/B signal to downstream.
3 OUTPUTS |HDMI signal scaling output for video wall.
4 12V/3A DC 12V/3A power supply port.
5 GND Ground the product housing.
6 AUDIO TOSLINK:
OUTPUT |e Analog L/R audio output: 3.5mm Stereo Jack
. Digital SPDIF audio output
BALANCED OUT: 5-pin phoenix connector, 20Hz ~ 20kHz, 1.5Vrms max.
7 SERVICE Firmware update port
8 CONTROL |LAN: Unit IP control
RS232-CTL: Unit RS232 control
RS232: Loop out from RS232-CTL

www.seada.co.uk
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3. Connection Setup

3.1.RS232 wiring

RS-232 control, baud rate 57600, 3-Pin Phoenix connector

Tx
Ground

Rx

RS232.CTL

D

3 Pins Phoenix Connector '
Female RS232

' RS232 to USB

3.2.RS232 and Ethernet Connection

Connect the G24 HDMI unit with the control PC using either CAT cable or wired serial cable.

4. G24 Software User Guide

Users can run the G24H.exe software directly without installation. Software can be downloaded from
the SEADA website. Double click the G24H software to get the Ul as below:

Switch | Signal Setting | PQ&Position | Video Wall | Network Setting

LOOP OUT AUDIO OUTPUT

B/MAIN 1 1 Audio Output 1 1

BT

Port Status Reading: Output Board4 ->Signal Type Succeeded
Reading: Output Board4 ->Signal Type Succeeded
Reading: Output Board4 - >Signal Resolution Succeeded
Reading: Output Board4 -=Signal Resolution Succeeded
K3 192.168.0.247 AB4CSEE4E2F3 3015 Reading: Output Board4 ->Signal Resolution Succeeded
Reading: Screen Combine Succeeded

Reading: All Information Succeeded!

Readina: Outout Board1 ->Sianal Resolution Succeeded

Device Name IP Address MAC Address Version

There are 5 main tabs in this software to help users set up and control the G24 HDMI video wall
controller.
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4.1. Matrix Switch

Users can connect the G24 HDMI device to control PC and set up the device as matrix switcher in this
section.

4.1.1. Connect to the G24 HDMI via UART for RS232

Connect the G24 HDMI to the control PC with a serial cable (see 3.1 for cable wiring)

Ctrl Mode If the software was connected via UART
@ UART O MNetwork  Port v Status (RS232) last time, software will connect
to the G24 HDMI automatically via
RS232. If it was used at Network last time, a ‘Network Timeout’ error message will be shown on
screen and users need to set up as below for RS232 connection in the software

. Choose ‘UART instead of ‘Network’
o Select the COM port from the Port dropdown menu
. Press ‘Disconnected’ button to connect

The software will check all the parts of the device. A ‘Read data succeeded’ dialog box will be shown
on screen when finished.

4.1.2. Connect to the G24 HDMI via Network
The default IP address for G24 HDMI controller is 192.168.0.247, Users need to change the IP
address of the control PC to the same network segment as the G24 HDMI.
¢ Change the ‘Obtain an IP address automatically’ to ‘Use the following IP address’ to set up a
static IP address of TCP/IPv4 in Ethernet Properties

>|P address: any address between 192.168.0.2 and 192.168.0.254 except the address which has
been taken by the G24 HDMI

>Subnet mask: 255.255.255.0, Default Gateway: 192.168.0.1

Ctrl Mode

OUART @Network  Port - Status

Device Name IP Address MAC Address Version
K3 192.168.0.247 AGACSEE43EF9 3015

Connect the G24 HDMI with a CAT cable to the control PC (cable included in the package)

If the software was connected via Network last time, software will connect to the G24 HDMI
automatically via network. If it was used at serial port last time, a ‘Please select COM port’ error
message will be shown on screen and users need to set up as below for Network connection in the
software

¢ Choose ‘Network’ instead of ‘UART’

¢ Press ‘Search Device’ button to find the G24 HDMI on the network

¢ Highlight the device Press ‘Disconnected’ button to connect

www.seada.co.uk
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4.1.3. Matrix Switch Routing
Users can switch and assign different inputs to the selected outputs in the matrix. The name of the
output can also be changed by selecting the default name — HDMI 1 and replacing it with the chosen
name.

itch | Signal Setting | PQ&Position | Video Wall | Network Setting English v

INPUT
HD A HD B

LOOP OUT AUDIO OUTPUT

B/MAIN 1 1 [ ) Audio Output 1 1 | B

Users need to disable the video wall mode (Cancel the splicing) to enable the matrix switcher mode
e LOOPOUT: Choose input source for B/MAIN output port.
e AUDIO OUTPUT: Choose audio source for balanced audio output and Mini Toslink output

4.1.4. Allset, Recall, Save As and Reset

Allset

| @ port [S N Stows

e The Allset dropdown menu helps the users select a single input to be displayed on all of the
screens (i.e. Allset HD A would display Input A on Output 1, Output 2, Output 3 and Output 4)
e Reset: Reset the unit to default factory configuration.
o EDID:

20 UM v Read: read the EDID of the selected output

EDID Rent Pt st v" Save: save the displayed EDID after ‘Read’

- v' Open: open an EDID from previous saved EDID

. v' Write: write the current displayed EDID onto selected input
. 00 Ve il to customized input EDID

4K60-5.1CH
4K30-2.0CH

B0 81 B2 83 84 1080P-2.0CH

B3 OC a0 8E oF

1280x1024-2.001
MANUAL

o 1080P-5.1CH

0 7200-2.00H

- 1024x7628-2.0CH
": 1920%1200-20CH
e 1680x10%0-2.0CH
@ 1600x1200-20CH
7 14400500-2.0CH
%0 1400x1050-2.0CH
b 1360768-2.0CH
28

%0

8

e

£

L)

www.seada.co.uk



“SEADA G24 HDMI User Guide

Showing the World

4.2. Signal setting

Switch Signal Setting lPQ&Position Video Wall | Network Setting

—Input Board—l Read AIII Output Board—l Read AIII
Label Input Type Input Format Label Output Type Output Format

1 HD A HDMI 3840x2160p60
HD B HDMI 3840x2160p60

UHD-HDMI /| 1920x1080@6C v
UHD-HDMI ™| 1920x1080@6C
UHD-HDMI | 1920x1080@6¢ v
UHD-HDMI v | |1920x1080@6¢

W N -

Signal Settings tab, users can use the ‘Read All’ function button to recognize the type and resolution
automatically. Additionally, you can also manually read one Input/output at a time — pressing the
Read button next to the selected input will only read that input alone.

. Input Type Shows the input video sources type (HDMI or DVI)
1l Input Format Shows the resolution of the input video sources

i, Output Type

¢ UHD-HDMII Set the respective output signal to HDMI without HDCP.

¢ UHD-DVI Set the respective output signal to DVI, with no audio output

e UHD-HDMII 1.4 Set the respective output signal to HDMI with HDCP 1.4 compliance.
e UHD-HDMI 2.2 Set the respective output signal to HDMI with HDCP 2.2 compliance.

Iv. Output Format

Users can manually change the output resolution here to match the requirement of the receiving
side (the default setting is 1920 x 1080@60, there are total 14 preset resolutions to choose from)

Output Format

1 1920x1080@6C ~ | |Reac
| |3840x2160@60 —_—
3840x2160@50
~ | 19201 200@ 60 Reaa
1920x1080@a0
1920x1080@50
16001 200@60
1400 1050@60
1366x768@a0
1360x708@60
1280x1024@60
1280x708@60
1280x720@ B0
1280x720@ 350
1024x768@60

Reac

www.seada.co.uk
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4.3. Fine Tune:PQ
Switch] Signal Setting PQ&Position |Video Walll Network Settingl
Select PQ FineTune Port- Outputl v
S annee 5 This section allows the user to fine-tune the settings of
Contrast  ® their screen from the G24H software.
Saturation ] .
Sharpness v The dropdown menu at the top of the section allows the
Terperatire (Go0) Read user to select which screen to apply the settings to.
% Read The read option reads the settings of the monitor/screen
: [ - that are already in place and adjusts the values in the
C ] my software, while the reset button will reset the settings to
% e their default after they have been manually adjusted.
4.4. Video Wall

Switch ] Signal Setting ] PQ&Position Video Wall I Network Setting I
——  VideoWall Setting —— Video Wall
Rows 2 [ ]
Columns 2 ] Screen 1 Screen 2
Available 4 L
l Set | | Read | Screen Splicing
Cancel Splicing
Bezel Setting Screen 3 Ser Screen 2 - Cancel Splicing
Type: A B
BES ® O Input Select >
A —
. - tput Sel >
Output Type >
Output Format >
T —
180° >
Set
Test Pattern >
T Layout Save/Load =
Save Layout ” Load Layout
Device Setting
Device ID v
First Output Index 5%
Set

uses can set up the video wall layouts and signal configuration in this section

4.4.1. Video Wall Layout Setup

VideoWall Setting —
Rows 2 Lt} Users can set up the layout of the video wall in ‘VideoWall Setting” by
Columns 2 g simply choosing how many rows and columns the video wall consists
S v of. Total screens amount is up to 4 for one G24 HDMI video wall
I Set “ Read I
controller.
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4.4.2. Creating the video wall

Video Wall
Screen 1 Screen 2 Click to select the screen, then drag & select the
screens to splice, right-click, and click Screen splicing
Screenaplicing to form a video wall.
Cancel Splicing
Screen 3 Ser Screen 2 - Cancel Splicing .. . .
° Screen Splicing - This combines the selected
Input Select ? . . .
screens into one and displays the selected input
Output Select > .. .
across all the splicing screens. For example, in the
Qutput Type >
Gitput Fomat 5 setup below 2x2, if all of them are spliced, then the
180° N input selected by the user will be displayed across all
Test Pattern > the 4 screens (Note: this is not the same as

duplicating a single input on each output).

e Cancel Splicing — This will cancel the video wall and revert to the matrix switching mode.

e Screen - Cancel Splicing — Remove the single screen x from the video wall to allow the
displaying another full frame image within the video wall configuration

e Input Select — Use the sub-menu to select the input to display on the video wall or the
secondary input image shown in the above example.

e Output Select — The user can control which screen should be mapped to which output (only
available in matrix mode)

e  Output Type — Allows the user to adjust the type of the output (only in matrix mode)

e  Output Format — Controls the resolution of the output (only available in matrix mode)

e 180° - Rotate the selected screen 180°.

e Test Pattern — To display Color Bar pattern on the screen

4.4.3. Bezel Correction

Users can set up the bezel correction for the video walls here to compensate the frame of the
screens to make the whole video wall look like one large screen without any distortion. Users can
either use pixels of the screen frame width or millimeter of the screen display area to set up the
bezel correction here

‘ Out Width{mm}

Bezel Setting Bezel Setting

Panel Border

Type: @A Type: A @B

Left{Pixels) 100 OutWidth(mm) [ ]
Right(Pixels)  [100 Ioner Width(enm) [ |||
Top(Pixels) 100 OutHeighttnm) [ |
Bottom(Pixels) 100 Inner Height{mm) I:I

:

IEﬂ

Valid Area Inner Height{mm)

Inner Width{mm) ——

4.4.4. Save and Load Pre-set Layout

Layout Save/load =~ ——— The user can save the video wall preset layouts and load it later via
[s”e Layout || Load Layout | the Save Layout and Load Layout dropdown menu. Users can save
up to 10 preset layouts here. Users also can recall these preset

layouts via 3™ party controller though IP or RS232

www.seada.co.uk
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4.4.5. Daisy Chain
Users can set up the daisy chain for multi units of G24 to achieve a big video wall (up to 16x16). A
four units daisy chain to form a 4x4 video wall will be used as an example below.

I.  Set up the Devices’ ID and First Output Index

Device Setting ——— | Users need to configure each unit with unique ID and output Index
Device ID + || to enable control software to be able to recognize and control them
First Output Index v in one system.
Set . . . .
= All units come with default Device ID:1 and First Output Index:1.

Users only need to set up from 2" G24.

Device ID First Output Index
G24 unit 1 1 1
G24 unit 2 2 5
G24 unit 3 3 9
G24 unit 4 4 13

First Output Index = 1 + (N-1) *4, N is the device ID

Noted: Any unit with Device ID being more than 1, G24 control software will not be able to connect
it individually since the software will try to find device with ID 1 first. However, users are still able to
change the Device ID and First Output Index without being connected properly.

1. Serial Ports Connection

Users are only able to use Serial port to connect and control the G24 units when they are working in
daisy chain mode.

RS232-Control Port RS232 Port
G24 unit 1 To PC/Laptop To RS232-Control port on unit2
G24 unit 2 To RS232 port on unitl To RS232-Control port on unit3
G24 unit 3 To RS232 port on unit2 To RS232-Control port on unit4
G24 unit 4 To RS232 port on unit3

Note: Please make sure the serial cable between G24 units is cross wired. Tx to RX, G to G and RX to
TX

BALANCED OUT YOS'UM(

B/MAIN

A
wour

www.seada.co.uk
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1. HDMI Cables Connections
Inputl Input2
, N
Unitl || & |5 =
HDA B/MAIN HD1 HD2 HD3 HD4
INPUT 1 Loopout ouTPUTS 4
\ J
I [ \
Unit 2 a0 =) E; e ==
HDA HDB B/MAIN HD1 HD2 HD3 HD4
' LoopouT 4 OUTPUTS
\ J
4 N\
Unit 3 =9 |92 S
A B/MAIN HD1 HD2 HD3 HD4
INPUTS = LOOP OUT 1 OUTPUTS ",
4 )\
Unit 4 l B = 8= || =
HDA HDB A B/MAIN HD1 HD2 HD3 HD4
| LOOP OUT C OUTPUTS y,

Connect all the inputs with video sources and outputs with video wall screens using professional AV

HDMI cables.

Iv.

Setup in the Software

Switch | Signal Setting | PQ&Position | Video Wall| Network Setting |

OUTPUTS

Switch | Signal Setting | PQ&Position. Vi

VideoWall Setting
Rows 4 ]
Columns 4 ]
Available 16

Bezel Setting
Type: @A OB

Left(Pixels) 0
Right(Pixels) 0
Top(Pixels) 0
Bottom(Pixels) [0

Layout Save/Load

Load Layout

Device Setting

Device ID

< | <

First Output Index
Set

LOOP OUT

ideo Wall I Network Setting l
Video Wall

AUDIO OUTPUT

Engich

>

INPUT

Screen Splicing

Cancel Splicing
Screen 6 - Cancel Splicing
Input Select

Output Select

Output Type

Output Format

180°

Test Pattern

Run the G24 software and connect through
RS232-control on device 1 and software will
detect all 4 G24 and display 16 outputs in
the software like below.

In Video Wall, set up the desired video wall
layout by choosing the correct Rows and
Columns in Video Wall Setting.
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4.5. Network Setting

Suitch | Signal Setting | PQ&Position | Video Wall Network Setting. |

& Select config port

Search List (Click device to load configuration) @Port0 ([ Portl Port 2
Device Name IP Address MAC Address Version 57600
K3 192.168.0.247 A6ACSEE4E2F3 3015 . o
Contro Norne

pC Jornain 192.168.0.201

[search Device| [Open Website] [Find via UART]

I

User Narme admin Subnet Mask | 255.255.255. 0 Package Length(Byte;

Basic config TCP Server
- MAC Address Transparent transmis
e ID 1P Type Static IP v None
Sevice IDType[0 | Staficlp 192.168. 0 .247

ssvord admin Gateway 192.168. 0 . Sync BaudRate(RFC2217 similar)

| pvmE, |
Save Config Save Config

Users can find all the device network information in this section and do the modification if needed.

Users can change the IP address of this unit in this section to fit the network requirement of
controlling system.

The device port here is for TCP/IP controlling from any 3™ party controller. Default is 23 and
recommend to keep it unchanged unless it is necessary.
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5. Command Lines
All the ASCIl commands given in this section use the following RS232 port settings:

e Baud Rate: 57600
e DataBits: 8

e Parity: None

e StopBits: 1

All the ASCII RS232 commands given in this section can also be sent to the LAN port using the
following settings:

e Default IP Address: 192.168.0.247

o Default Network Mask: 255.255.255.0
o Default Gateway: 192.168.0.1

e Port: 23

Notes:

e All commands in this section are always terminated with the ASCII carriage-return character,
0x0d. This is represented by the* symbol in each command.

o All responses are always terminated with the ASCII carriage-return and line-feed sequence
(0x0d 0x0a).

o All spaces shown in the command are required. Lowercase letters are used as value
placement indicators, the required value or identifier is given in the Details panel for each
command.

5.1. Recall/Save Preset Layouts of Video Wall

Operation Spacer Target Spacer | Command Command Command tail
type type arameters
vp (1byte) | (Nbytes) | (1byte) | " P (1 byte)
(3 byte) (10 bytes) | (1/2/3 bytes)
SET/GET Space SYS Space ROUTE- X/ XX/ XXX «
MODE
X is the mode This is ASCII
value carriage return
0x0d
A. GET (Recall) the route mode saved before:
For example, GET (Recall) the video wall preset layout 1
Send: GET SYS ROUTE-MODE 1+ Receive: SYS ROUTE-MODE 1
B. SET (Save) current route to a mode:
For example: SET (Save) current layout to preset layout 1
Send: SET SYS ROUTE-MODE 1+ Receive: SYS ROUTE-MODE 1

www.seada.co.uk
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5.2. Matrix Video Routing
Operation | Spacer Target Spacer | Command Command Command tail
type type arameters
P (1 byte) (N bytes) (Lbyte) | P P (1 byte)
(3 byte) (10 bytes) (N bytes)
SET Space INX/INxx/INXxxx Space VIDEO OUTa [oUuTb | <
OUTc... -
X is the input port I This is ASCII
number or carriage
return 0x0d
ALL

For example,
IN1/INO1/INOO1

Set video route: Input port-x/xx/xxx switch to output port-a/b/c..., or all output ports
For example: SET video route: Input port 1 switch to output port 1
Send: SET IN1 VIDEO OUT1+
For example: SET video route: Input port 1 switch to all output ports
Send: SET IN1 VIDEO ALL+

Receive: IN1 VIDEO OUT1

Receive: IN1 VIDEO ALL

5.3. Audio out Selection
Operation | Spacer Target Spacer | Command Command Command tail
type type arameters
vp (1 byte) (N bytes) (1byte) | P P (1 byte)
(3 byte) (10 bytes) (N bytes)
SET Space INX/INxx/INxxxX Space AUDIO- LR \
ROUTE -
x is the input port This is ASCII
number carriage

For example,
IN1/INO1/INOO1

return 0x0d

www.seada.co.uk

Set audio from input x to LR and TOSLINK out
For example: SET audio from Input port 1 LR and TOSLINK out
Send: SET IN1 AUDIO-ROUTE LR+

Receive: IN1 AUDIO-ROUTE LR
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5.4. Choose Input Source for B/MAIN Output Port
Operation | Spacer Target Spacer | Command Command Command tail
type type arameters
P (1 byte) (N bytes) (Lbyte) | P P (1 byte)
(3 byte) (10 bytes) (N bytes)
SET Space INX/INXx/INXXX Space LOOP- MAIN !
ouT -
X is the input port This is ASCII
number carriage

return 0x0d

For example,
IN1/INO1/INOO1

e Choose Input Source for B/MAIN Output Port
For example: SET video from Input port 2 to B/MAIN loop out
Send: SET IN2 LOOP-OUT MAIN+ Receive: IN2 LOOP-OUT MAIN

5.5. Read Device IP Address
Operation Spacer Target Spacer Command Command Command tail
e e arameters
P (1 byte) (N bytes) (1 byte) P P (1 byte)
(3 byte) (10 bytes) (N bytes)
GET Space SYS Space IP !
This is ASCII carriage return
0xod

For example, GET the device [P (MAC: A64C5EE4E2FB)
Send: GET SYS IP+ Receive: SYS IP A64CSEE4E2FB STATIC,192.168.0.247,255.255.255.0,192.168.0.1

www.seada.co.uk
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6. Troubleshooting

6.1. No Connection

6.1.1.Ensure the G24 HDMI is powered up

6.1.2.Ensure the PC and G24 HDMI at the same IP group

6.1.3.Ensure the right connection mode is selected (IP or RS232)

6.1.4.No Signal sign or black screen will be shown on screen when no video input is applied.
6.2. No Output

6.2.1.Ensure the video source is on

6.2.2.Ensure the video source device sends the signal out (G24 HDMI INPUT statue LED light
will be on if input video signal presents)

6.3. Black screen
6.3.1.Ensure the G24 HDMI and screens are powered up
6.3.2.Ensure the connection to screens are OK
6.3.3.Ensure the screens on correct channel (DVI or HDMI)

6.3.4.Ensure that the inputs are assigned correctly (i.e. Input 1 on Output 1, Input 2 on
Output 2 etc.
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